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SUMMARY 

We review the time series econometrics package TSMod. The new features in TSMod 4.03, released in April 

2004, are described and its potential for teaching is analysed. Copyright ? 2005 John Wiley & Sons, Ltd. 

1. INTRODUCTION 

TSMod is an efficient, user-friendly, flexible Ox package for time series econometric analysis 

offering a wide range of univariate and multivariate, linear and nonlinear models. There are 

several things that we particularly like about TSMod. 

First, TSMod is easy to use since it features a menu driven, click and point, graphical user 

interface (GUI). Thus the user does not need to know Ox, the object-oriented, matrix programming 

language which is at the heart of TSMod. Moreover, the fact that TSMod is written in efficient Ox 

code makes it fast and hence particularly suitable to conduct Monte Carlo or bootstrap simulations. 

Second, the number of nonlinear time series parameterizations?including GARCH and related 

forms of conditional heteroscedasticity, long memory and regime-switching models?offered by 
TSMod's menus far exceeds what is currently available in popular packages such as EViews, 

Pc-Give, Rats, S-Plus and TSP. 

Third, it is an integrated package. Using the TSMod menus, it is straightforward to set up, 
estimate and test a model and then generate forecasts using the selected model. 

Fourth, it is inexpensive to buy. (Currently, the time-limited, academic version of TSMod is 

free. However, James Davidson, the author of TSMod, plans to charge a modest fee for it in 

the future.) 

* 
Correspondence to: Professor Ana-Maria Fuertes, Faculty of Finance, Cass Business School, 106 Bunhill Row, London 

EC1Y 8TZ, UK. E-mail: a.fuertes@city.ac.uk 

Copyright ? 2005 John Wiley & Sons, Ltd. 



692 SOFTWARE REVIEW 

Finally, advanced users can use TSMod to estimate any nonlinear dynamic equation that can 

be supplied as a function in Ox code. They can also call TSMod routines from within Ox when, 
for example, running Monte Carlo experiments. 

Of course, one can use TSMod just to calculate summary statistics and practice the standard 

OLS regression tools taught in basic undergraduate econometrics courses. However, this would be 
a waste of potential since the main comparative advantage of TSMod lies in its advanced features. 

TSMod is aimed primarily at researchers and students who have a good understanding of the 

econometric methods that they are applying. 

2. OVERVIEW 

A large range of models can be estimated using TSMod. In order to get a feel for the capabilities 
of TSMod, we looked at some recent financial econometrics textbooks?Franses and van Dijk 
(2000), Mills (1999), Tsay (2002) and Wang (2002)?and picked out some widely used models. 

We then checked whether or not TSMod facilitates them. TSMod provides the following tools 

inter alia: 

ARIMA and ARFIMA model estimates by ML with a pre-set maximum order feature allowing 
easy model selection; 
Bilinear autoregressive models by ML; 

ML and QML estimates of conditional heteroscedasticity models including GARCH, FIGARCH, 

HYGARCH, threshold ARCH, APARCH, EGARCH and GARCH-M; 

Regime switching models including simple Markov switching, Hamilton's dynamic Markov 

switching model, explained switching and smooth transition model components by ML; 
Linear equations using OLS, IV, 2SLS and GMM estimation methods; 
Linear systems using 3SLS, SUR, LIML/LGV and FIML methods; 
Nonlinear GMM models; 

Fully modified least squares (FMLS) estimation and models with equilibrium relations such as 

single-equation error correction models (ECM) and vector error correction models (VECM); 

Nonparametric (Naradaya-Watson) bivariate regression models; 
Parametric bootstrapped standard errors and p-values for test statistics. 

One powerful feature of TSMod is its flexibility in that many of the models listed above can 

easily be combined. For example, it is possible to estimate an ARFIMA model with a GARCH 

skewed Student's t random error including exogenous regressors in both the conditional mean 

and conditional variance equations. ARFIMA models can be estimated in both the time and 

frequency domains. 

There are a number of other attractive features. For instance, parameters can be fixed or subject to 

inequality constraints using a logistic map. Wald tests of linear restrictions are available. Score/LM 

and conditional moment tests can be calculated. The concentrated criterion function can be plotted 
in one or two dimensions. Rolling and recursive estimation options are available. Numerical 

optimization is carried out using the BFGS algorithm with the option of using the simulated 

annealing algorithm for starting values. In addition, stochastic simulation of the aforementioned 

models can be carried out and multi-step ex ante point forecasts including median forecasts of the 

mean and variance alongside 95% interval forecasts can readily be produced. 

Copyright ? 2005 John Wiley & Sons, Ltd. /. Appl. Econ. 20: 691-698 (2005) 
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2.1. Recent Features 

The current version is TSMod version 4.03. A useful review of the earlier version 3.24 can be 

found in Bos (2004). However, as TSMod is continually evolving, the latter is already a little out 

of date. The fact that James Davidson has produced three new versions of TSMod in the first 

four months of 2004 bears this out! We should also note that TSMod's author is very open to 

suggestions and comments and, quite importantly, responds very promptly to queries. We envisage 
an active internet discussion list for TSMod users in the near future! 

The major changes in v4.03 relative to v3.24 are: (i) The addition of useful system estimation 

routines?simultaneous equations models, VECMs, univariate and multivariate Markov-switching 

equations and multivariate GARCH models?including the ability to estimate user-programmed 
nonlinear systems; (ii) Johansen-type tests of cointegrating rank and MINIMAL analysis of the 

cointegrating space; (iii) the graphical user interface has been improved and icons for common 

commands have been added. 

The multivariate GARCH model may interest many users. In the univariate case, the basic 
1/2 

GARCH model may be expressed as yt = y + ut where ut = ht et, et 
~ 

iid(0, 1) and ft(L)ht 
= 

K + a(L)ut. The multivariate extension of this has the vector form ut = H/ ef, where H, = 

diag(h,), er 
~ 

iid(0, C) where C is a correlation matrix with ones on the main diagonal. 

3. GETTING STARTED 

3.1. Installation 

Comprehensive instructions for installing TSMod in Windows and Linux operating systems are 

given in the documentation (Appendix A) provided with the program. The latest version of TSMod 
can be downloaded from James Davidson's web page http://www. ex. ae .uk/~jehd 
201/. Several other necessary software components?such as GnuDraw, GnuPlot and OxJapi? 
are bundled along with TSMod. 

In order to use TSMod in the standard GUI or windows point-and-click form, the following two 

programs need to be installed: (i) the free console version of Jurgen Doornik's Ox 3.3 program 
which may be downloaded from http: / /www. doornik. com/; (ii) the free Java Runtime 
Environment (JRE) downloadable from http: / / j a va. s un. c om /j2se/1.4.2/ down 
load. html. Installation is completed in four steps. The current version of the program usually 
resides in c : /program files/ox/packages . 

Most users will probably launch TSMod using an easily set up Windows shortcut. However, it 
can also be run as a module from within OxEdit (or GiveWin) by clicking on File?>Open-^ 
TSMod Run and then Modules-^Run Default Module. A nice feature of TSMod is 
that advanced users can call the TSMod routines and access their output when programming Monte 

Carlo experiments or bootstrap simulations in Ox code. 

3.2. Documentation 

There is a learning curve when first using TSMod, because the program is so flexible, but it is not 

very steep. TSMod comes with a range of documentation: (i) a Guide to the package; (ii) a User's 
Manual which is also accessible through the program Help pages; (iii) a series of Appendices; 

and (iv) a Programming Reference. 

Copyright ? 2005 John Wiley & Sons, Ltd. J. Appl Econ. 20: 691-698 (2005) 
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TSMod is not a commercial package as yet and it is designed for relatively experienced users. 

Nevertheless, the Guide is too cryptic at times when describing the large variety of models which 
TSMod can handle. New users would find it helpful if some of the more popular models were 

described in more detail. For instance, the sequence of menu and option settings used to set them 

up could be discussed. Basic examples of how to test joint parameter restrictions and analyse 
the cointegrating space would be useful. More detailed examples using available data sets could 
also be presented so that new users could familiarize themselves with the software by trying to 

replicate the results. 

New TSMod users should print out a copy of the User's Manual since a lot of the infor 
mation they need is set out there. The User's Manual provides a detailed description of the 
menus and options available in the GUI version of TSMod. However, if some of the tech 
nical aspects were illustrated via examples based on real data, it would be more fun to read 

through it. Also an alphabetically ordered index of contents for easy reference would be very 
useful in order for the user to find specific information quickly. Advanced users will find 

the Appendices and the Programming Reference clear and helpful. The Appendices show how 
to include user-coded (Ox) functions in the TSMod routines, how to call TSMod routines 
from an Ox program and how to generate artificial data (simulations) using the different mod 
els available. 

3.3. Data Handling 

TSMod can read data from the following sources: (i) Excel (.xls) and Lotus (.wkl,.wks) work 

sheets; (ii) Ox/GiveWin (.in7, .dat) datafiles; (iii) Stata (.dta, versions 4 to 6) datafiles; (iv) Gauss 

(.dht) datafiles; (v) ASCII files with the .mat file extension containing a data matrix with variables 

in columns, observations in rows and the number of rows and columns in the first line. Data can 

be written to Excel, Lotus, Ox/GiveWin and ASCII data files but, unfortunately, not to Stata or 

Gauss data files. Of course, a program like StatTransfer can be used to transfer data from other 

data file types. Two or more data files can be merged in TSMod. 

TSMod is a reasonably robust package. It will crash on occasion if you play around enough 
with a variety of model settings. However, in almost all cases, the problem is resolved when you 
start up TSMod again. The latest settings are restored and one can estimate the model previously 
set up. New users should generally reset the settings in TSMod whenever they start formulating 
a new model. 

4. USING TSMOD FOR TEACHING 

We believe that the main reasons why an applied econometrics lecturer might choose to adopt 
TSMod for teaching purposes are (i) TSMod is an advanced package offering state-of-the-art time 

series estimation methods and models, (ii) TSMod uses a menu-driven GUI and (iii) TSMod 

is inexpensive. It is ideal for research purposes and for teaching advanced undergraduate and 

postgraduate econometrics courses. Students and researchers who can program in Ox will also 

certainly benefit from the easy interaction between TSMod and Ox. Below we outline a series of 

advantages (pros) and disadvantages (cons) of TSMod. 

Copyright ? 2005 John Wiley & Sons, Ltd. /. Appl. Econ. 20: 691-698 (2005) 
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4.1. Transforming Data, Session Logs and Data Summaries 

Through the GUI, most common data transformations (logarithms, lags, differences, scaling, etc.) 
can be performed, dummy variable and trends can be created and individual observations can be 

edited on the fly (pro). However, more complicated transformations will have to be performed prior 
to reading the data in TSMod since the package does not have a calculator or algebra editor tool 

similar to those in GiveWin (con). Take the daily S&P series used in Franses and van Dijk (2000). 
It can be transformed into daily returns through Setup? Data Transf ormation-*Log 
Dif f erence. This automatically creates a new variable called DlLog_S&P. The user can then 

rename the series if desired. The new data file (that contains both the original series and the 

transformed series) can be saved through File-* Data?>-Save. Various default file types can 

be specified (pro). A listing of data transformations appears in the session log file and on the 

screen (pro). 
How does TSMod handle missing data? Suppose that a single observation for a single variable, 

say the 30th data point, is missing from the data set. TSMod will estimate a model including 
this variable by dropping all observations up to observation number 30. This is fine for most 

dynamic time series models, the focus of TSMod, but not if you want to estimate a static 

OLS regression. 
One nice feature of TSMod is that the output of the session can be cumulated in an output/session 

log file (pro). This feature is useful for teaching purposes. For example, when correcting course 

work/assignments this provides an easy way to re-trace the student's steps in the econometric anal 

ysis. This can be specified at the beginning of a session through File-^Results-> Enable 

Background Saving or New Results File. Perhaps the default setting should be to 

keep a session log. Of course, the user can save selected results using File->Results-^Save 

Selected Text. 

One can produce summary statistics through the Actions? Compute Summary Sta 

tistics options. Besides the usual statistics, the latter provides several I(0)/I(1) tests by 
default (pro). These are Lo's RS test, the KPSS test, the Phillips-Perron test and Robinson's d 
test. In contrast with other common packages such as EViews, it gives the observation number 
at which the max and min occurs (pro). Perhaps the data transformation, summary statistics and 
data graphs options should appear under the same menu heading. In addition, a check box could 
be added to the summary statistics dialogue to enable statistics, correlations and so forth to be 
calculated in one go (con). 

4.2. Econometric Analysis 

Different estimators, as well as the sample to be used, can be chosen through Setup->Esti 
mation and Sample option. One can also specify systems estimation and the use of 
differenced data. The regression model is specified using Model->Linear Regression. 
One can also access IV, GMM, 2SLS, 3SLS and FMLS using this menu. ARFIMA, GARCH, 

regime-switching models and other parameterizations involving equilibrium relations (e.g. ECM 
and VECM) are selected through the Mo del - 

Dynamic Equation option. 
By default, TSMod reports several diagnostic tests alongside the estimation results (pro). 

These include the residual skewness and kurtosis, the Jarque-Bera test for normality, a residual 
autocorrelation test (Box-Pierce) and a test for heteroscedasticity (Box-Pierce test for the 

squared residuals). The lag length for these tests can be set using Options->Test and 

Copyright ? 2005 John Wiley & Sons, Ltd. J Appl. Econ. 20: 691-698 (2005) 
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Diagnostics Options, since the default value of 12 may not be appropriate in many cases. 

Additional tests for autocorrelation and heteroscedasticity, including neglected ARCH effects, may 
also be called for (pro). In the case of ARMA models, TSMod reports the real and imaginary part 
of the AR roots and their moduli (pro) but not the inverted MA roots as EViews does (con). The 

reported standard errors are obtained from the White robust covariance matrix by default. However, 
either the conventional or the Newey-West HAC robust standard errors may be selected instead 

using Options->Test and Diagnostics Options. 
TSMod also offers a nonparametric (Naradaya-Watson) bivariate regression module and some 

advanced estimation methods for cointegrating models such as FMLS. However, TSMod does not 

include a number of estimators which are widely used in conventional undergraduate econometrics 
courses such as GLS estimation (e.g. weighted least squares in the context of heteroscedastic 

errors), logit and probit time series models, and baseline panel time series models such as fixed 

effects and random effects (con). However, a wide range of time series models within the GARCH 

class are provided to deal with conditional heteroscedasticity (pro). 
With regards to inference, it is possible to compute score or conditional tests of hypotheses using 

Actions->Compute Test Statistics. Take the model yt = a + Pixu + fi2x2t + et 
and suppose that we want to test H0 : Pi + 4?2 = 1. In EViews this can be done simply by writing 

c(2) + 4 x c(3) = 1 in the test window. However, it is less obvious how to do this in TSMod and 

so, as noted earlier, it would be useful if the TSMod manual contained some data-based examples 

(con). It is possible to impose multiple parameter restrictions, such as the one above, in estimation 

through Models Parameter Constraints (pro). Simple Chow breakpoint tests are not 

readily set up from the menus after model estimation in TSMod (con). 
TSMod allows for recursive estimation based on increasing-size windows or a fixed-size rolling 

window and the sequence of parameter estimates can be subsequently plotted (pro). With regards 
to ARMA analysis, the estimated coefficients for AR models are virtually equal to those obtained 

in EViews (with the backcasting option off) and Pc-Give. However, the estimated coefficients and 

standard errors in ARMA models can differ. Table I reports estimates for an ARMA( 1,1) model 

of the daily S&P Composite series over the period 1/06/86 to 12/31/97 from Franses and van 

Dijk (2000). 
This example illustrates that the MA parameter estimate in TSMod is nearly identical to that from 

EViews and Pc-Give but with opposite sign! The reason for the latter is that their ARMA estimation 

routines are based on different default parameterizations of the MA lag polynomial. In TSMod, 
the latter is 0(L) = 1 ? 

OiL 
? ... ? 

0qLq, which accounts for the apparent sign discrepancy. The 

TSMod and EViews heteroscedasticity robust (White-type) standard errors for AR model estimates 

are virtually identical. However, they differ somewhat in the case of ARMA models, as Table I 

Table I. ARMA(1,1) estimates 

Parameter (robust s.e.) 

TSMod 4.03 EViews 4.1 Pc-Give 10.0* 

Intercept 0.00048 (0.0001) 0.00049 (0.0002) 0.00048 (0.0001) 
AR1 -0.71519 (0.1351) -0.71519 (0.2072) -0.73553 (0.0929) 
MAI -0.75705(0.1104) 0.75706(0.1757) 0.77509(0.0863) 

* 
Using the ARFIMA 1.01 package for Ox (Doornik and Ooms, 2003). 

Copyright ? 2005 John Wiley & Sons, Ltd. J. Appl Econ. 20: 691-698 (2005) 
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illustrates. The reason for this discrepancy is not obvious. The White standard errors from TSMod 

and Pc-Give are relatively close. 

A wide range of ARCH models can be estimated. At first sight (i.e. when using the default 

specifications), the results seem to differ greatly from those in other packages. However, users 

should be aware of the different ARCH parameterizations that TSMod permits. Take a simple 

GARCH(1,1) model. Estimates for the 'ARMA-in-squares' form of the GARCH equation are 

reported by default. However users may want to opt for the 'conventional form' of reporting 
results through Options-*ML and Garch Options. Care should also be taken in that, 

depending on how the GARCH model is written, two different intercepts (referred to as Type 
1' and 'Type 2') are reported. Most users will probably prefer the latter type of intercept 

which conforms with that reported in EViews and Pc-Give, namely 8 in the equation of 
= 

8 + as2__x + /tof_i? whereas the former is co in fi(L)(o2 
- 

oo) ? 
ae2_v By default, TSMod reports 

the 'Type 1' intercept but one can always revert to the conventional one through Options-^ML 
and Garch Opt i ons. Perhaps it would be more intuitive if the conventional parameterization 

options were the default ones, instead of the other way round. Table II reports the GARCH(1,1) 

parameter estimates and standard errors for the S&P series. 

As noted earlier, one of the strengths of TSMod is the wide range of univariate and 

multivariate models it offers for nonlinear time series analysis. In addition, TSMod allows 

richer dynamics by readily combining different models, e.g. an ARFIMA-GARCH specifica 
tion. 

Inevitably, the current version of TSMod has some limitations in terms of modelling/inference 
tools but the author is very open to suggestions. VAR models may be estimated in TSMod 

but the impulse response to an innovation shock is not automatically generated. It would be 

useful if the MacKinnon-Haug-Michelis critical values for cointegration tests were added to 

the package. As TSMod stands, some users may prefer alternative packages such as Pc-Give to 

carry out Johansen-style analysis of cointegrating vectors. Stochastic volatility and state space 
(Kalman filter) models are not included in TSMod but they both may be estimated using the 

Ox packages Stamp and SsfPack/SVPack. Bandpass (frequency) filters such as the Baxter-King, 

Christiano-Fitzgerald fixed length and Christiano-Fitzgerald asymmetric full sample filters would 
also be nice to have. The forecast capabilities of TSMod could be expanded somewhat to 

provide a range of forecast accuracy measures, to generate combined forecasts and to conduct 

baseline Diebold-Mariano type forecast accuracy tests and the Pesaran-Timmermann predictor 
dependence test. 

Table II. GARCH(1,1) estimates 

Parameter (robust s.e.) 

TSMod 4.03 EViews 4.1 Pc-Give 10.0 

Intercept (mean) 0.00065 (0.0001) 0.00065 (0.0001) 0.00065 (0.0001) 
Intercept (GARCH) 0.00133 (0.0005)* 1.72e-06 (6.32e-07) 1.701e-06 (6.28e-07) 

GARCH-AR 0.09261 (0.0538) 0.09174 (0.0514) 0.09092 (0.0514) 
GARCH-MA 0.89261 (0.0607) 0.89438 (0.0432) 0.89527 (0.0432) 

* 
Square root of Type 2 intercept as reported in TSMod output. 
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4.3. Graphs 

Unlike other Ox packages, TSMod does not make use of the graphics menu offered by GiveWin. 
Instead it comes with its own graphical platform which provides graphs with the same GiveWin 

layout and precision. Overall, the graphics capabilities in TSMod are reasonable. They are on a 

par with those in EViews. However, they lag behind those in GiveWin and in packages such as 

Pc-Give, TSP and Stamp which make use of the GiveWin interface directly. 
Data plots include time series plots, correlograms, histograms and normal QQ plots. Equation 

plots include actual values and fitted values, residuals, conditional variances, ex ante forecasts and 

plots of recursive and rolling parameter estimates. In terms of precision and colour display, the 
TSMod graphics are nicer than those in EViews. 

TSMod graphs may be exported/saved to a range of file types but not with ease if compared, 
for instance, with GiveWin. Moreover, it would be nice if the graphics saving capabilities were 

enhanced and some frequency domain plots were added. 

5. CONCLUDING REMARKS 

TSMod is an inexpensive, easy to use, flexible package for econometric research using time series 

data. TSMod currently dominates most econometrics packages in terms of the variety of nonlinear 

time series specifications it can handle. It can be used advantageously for teaching advanced 

undergraduate and postgraduate courses. We recommend it highly and hope that James Davidson 

will continue to produce regular updates. 
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